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ZA VA©U SIGURNOST 
Proèitajte ove kratke upute. Njihovo kr¹enje mo¾e biti opasno pa èak i 
protuzakonito. Vi¹e pojedinosti naæi æete u ovom priruèniku.

Ne ukljuèujte telefon tamo gdje je uporaba be¾iènih telefona zabranjena 
ni onda kada mo¾e prouzroèiti smetnje ili opasnost.

SIGURNOST U PROMETU PRIJE SVEGA Ne koristite komunikator dok 
vozite.

SMETNJE Svi be¾ièni telefoni podlo¾ni su utjecaju smetnji koje mogu 
umanjiti njihove radne karakteristike.

SKLJUÈITE TELEFON U BOLNICI Pridr¾avajte se svih propisa i uputa. 
Iskljuèite telefon u blizini medicinskih ureðaja.

ISKLJUÈITE TELEFON U ZRAKOPLOVU Be¾ièni telefoni mogu u 
zrakoplovu prouzroèiti radio smetnje.

ISKLJUÈITE TELEFON NA BENZINSKOJ CRPKI Ne koristite telefon na 
benzinskoj crpki. Ne koristite ga ni u blizini zapaljivih tvari i kemikalija.

ISKLJUÈITE TELEFON NA PODRUÈJU MINIRANJA Ne koristite telefon 
na podruèju gdje se provodi miniranje. Pazite na ogranièenja i dr¾ite se 
svih danih uputa i va¾eæih propisa.

KORISTITE PA®LJIVO Koristite ga samo u uobièajenom polo¾aju. Bez 
potrebe ne dirajte antenu.

OVLA©TENI SERVIS Ugradnju i popravak telefonske opreme smije obaviti 
samo ovla¹tena osoba.
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DODATNI PRIBOR I BATERIJE Koristite samo odobren dodatni pribor i 
baterije. Ne povezujte meðusobno neuskladive proizvode.

VODOOTPORNOST Va¹ komunikator nije vodootporan. Pazite da ne doðu 
u doticaj s tekuæinom.

PRIÈUVNE KOPIJE Ne zaboravite napraviti prièuvne kopije svih va¾nih 
podataka.

POVEZIVANJE S DRUGIM UREÐAJIMA Pri povezivanju s bilo kojim 
drugim ureðajem, u priruèniku dotiènog ureðaja prouèite sve va¾ne upute. 
Ne povezujte meðusobno neuskladive proizvode.

UPUÆIVANJE POZIVA Zaklopite komunikator i provjerite je li telefon 
ukljuèen i prikljuèen na mre¾u. Unesite broj telefona zajedno s pozivnim 
brojem, a zatim pritisnite . Za zavr¹etak poziva pritisnite . Za 
odgovaranje na poziv pritisnite .

HITNI POZIVI Zaklopite ureðaj. Provjerite je li telefon ukljuèen i prikljuèen 
na mre¾u. Za brisanje zaslona, pritisnite  onoliko puta koliko je to 
potrebno (npr. za zavr¹etak poziva, izlaz iz izbornika, itd.). Unesite broj 
hitne slu¾be, a zatim pritisnite . Ka¾ite gdje se nalazite. Ne prekidajte 
vezu dok ne dobijete odgovarajuæe upute.
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Kad otvorite prodajni paket, provjerite sadr¾i li sljedeæe:
• Dvije naljepnice prilo¾ene su u paketu zajedno s ureðajem 
• Nokia 9210i Communicator
• Korisnièki priruènik za Nokia 9210i Communicator, popis postavki, ovaj 

zajednièki Kratki priruènik s uputama za dodatni pribor i Upute za dodatne 
aplikacije

• Bateriju velikog kapaciteta BLL-3
• Punjaè ACP-12
• RS232 prikljuèni kabel DLR-2L
• CD za Nokia 9210i Communicator

Kori¹tenje telefona
Savjet: Za kori¹tenje 

programskih uputa, 
rasklopite ureðaj i pritisnite 
tipku  (pomoæ).

Za upuæivanje i primanje poziva i poruka na va¹ Nokia 9210i Communicator, 
trebaju biti ispunjeni ovi uvjeti:
• telefon mora biti ukljuèen,
• u njega treba biti ulo¾ena odgovarajuæa SIM kartica i 
• morate se nalaziti u podruèju djelovanja be¾iène mre¾e.

Hitni pozivi na meðunarodne brojeve hitne slu¾be mogu se u nekim mre¾ama 
upuæivati i bez SIM kartice. Provjerite to kod svog mre¾nog operatora.

VA®NO: Va¹ se komunikator mo¾e zakljuèati pomoæu koda za zakljuèavanje. 
Pretpode¹en kod za zakljuèavanje je 12345. Iz sigurnosnih razloga kod 
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sigurnom mjestu, odvojeno od komunikatora. Vi¹e pojedinosti o 
promjeni koda za zakljuèavanje naæi æete u korisnièkom priruèniku, u 
odjeljku ‘Security’ na stranici 216. Imajte na umu da vam nijedan 
sustav s lozinkom ne mo¾e zajamèiti apsolutnu za¹titu od neovla¹tena 
pristupa.

Prvo pokretanje
Opaska: Sve minijaturne SIM kartice dr¾ite izvan dosega male djece.

1 Zaklopite ureðaj i provjerite je li telefon iskljuèen. Ako je ukljuèen, pritisnite 
.

2 Ako je baterija ulo¾ena u komunikator, izvadite je. Pritisnite zapor pri vrhu 
baterije i izvucite je iz le¾i¹ta. Vidi sliku 1.
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Slika 1

3 Umetnite SIM karticu u odgovarajuæi utor: pazite da pozlaæeni kontakti SIM 
kartice budu okrenuti prema dolje te da isko¹eni ugao kartice bude s desne 
strane. Vidi sliku 2.
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Slika 2

Ako je SIM kartica pravilno umetnuta u utor, vidjet æe se isko¹eni ugao, kao ¹to 
je to prikazano na slici 3.

Slika 3 vidi se isko¹eni ugao
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baterija gotovo ili potpuno ispra¾njena, prije nastavka zapoèete procedure 
preporuèljivo je komunikator prikljuèiti na punjaè i zapoèeti s punjenjem 
baterije. 

5 Rasklopite komunikator. Na zaslonu æe se pojaviti poruka dobrodo¹lice i 
provesti postupak samoispitivanja.

Savjet: Podatke o svom 
gradu, vremenskoj zoni te 
obliku zapisa datuma i 
vremena u svom æete 
komunikatoru moæi kasnije 
izmijeniti koristeæi Control 
panel (Odrednik) te 
aplikacije Date and time 
(Datum i vrijeme) i Regional 
settings (Lokalne postavke).

6 Nakon zavr¹enog postupka samoispitivanja, ukoliko postoji moguænost biranja, 
moæi æete odabrati odgovarajuæi postav tipkovnice. Kao potvrdu odabranog 
rasporeda, pritisnite OK (U redu).
U suprotnom, na zaslonu æe se pojaviti popis gradova.

7 Pomoæu tipke sa strelicama doðite do naziva svoga grada i pritisnite OK 
(U redu). Nakon toga na zaslonu æe se pojaviti prikaz toènog vremena i datuma.
®elite li potra¾iti odreðeni grad, u polje pri dnu prikaza unesite njegov naziv.

8 Po potrebi promijenite vrijeme i datum, a zatim pritisnite OK (U redu).
9 Nakon toga mo¾ete izmijeniti svoje podatke na posjetnici. Pritisnite OK 

(U redu).
Ako je u va¹ komunikator ulo¾ena ispravna SIM kartica, neki podaci na 
posjetnici mogu biti preuzeti sa SIM kartice. 

Savjet: Kasnije, pomoæu 
aplikacije Contacts (Adresar) 
svojoj posjetnici mo¾ete 
pridodati i sliku.

10 Na kraju se pojavljuje obavijest o uspje¹no zavr¹enom postupku pokretanja. 
Pritisnite OK (U redu).
Opaska: Ako SIM kartica nije pravilno umetnuta, baterija neæe sjesti u le¾i¹te. 

Ne poku¹avajte silom umetnuti bateriju! Provjerite jeste li SIM karticu 
umetnuli onako kako je prethodno opisano. Ako SIM kartica nije 
pravilno umetnuta, izvadite je iz utora i poku¹ajte ponovo.
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Savjet: Stanje 
napunjenosti baterije 
mo¾ete vidjeti preko 
odgovarajuæe oznake  na 
zaslonu komunikatora 
odnosno telefona.

1 Kabel punjaèa ukljuèite pri dnu komunikatora, kao ¹to je prikazano na slici 4.

Slika 4

2 Prikljuèite punjaè u zidnu utiènicu s odgovarajuæim naponom mre¾e. Tijekom 
punjenja, na zaslonu telefona pojavljuje se oznaka èija se duljina postupno 
poveæava.

3 Baterija je puna onog trenutka kada se oznaka smiri, a na zaslonu se pojave 
èetiri ¹tapiæa. Nakon toga punjaè mo¾ete iskljuèiti iz komunikatora.
Opaska: Tijekom punjenja komunikator smijete slobodno koristiti.
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Savjet: Prelazite li na 

Nokia 9210i Communicator 
sa starijih modela, u 
Korisnièkom priruèniku 
pogledajte ‘To transfer data 
from other devices’ na 
stranici 35.

Slika 5

Osnovni elementi raèunalnog podsustava, ukljuèujuæi zaslon, prikazani su na slici 
5. Zaslon se jednostavno ukljuèuje rasklapanjem ureðaja. Na zaslonu se pojavljuje 
zadnja aplikacija iz prethodnog kori¹tenja komunikatora.

Zaklapanjem ureðaja, raèunalni podsustav sprema sve podatke i iskljuèuje zaslon.

Naredbene 
tipke

Tipka sa 
strelicamaIzbornièka tipka

Tipkovnica
Tipka pomoæi

Aplikacijske
tipke

Zaslon
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pritisnete Close (Zatvori), prijeðete na neku drugu aplikaciju ili pak 
zaklopite ureðaj, Nokia 9210i Communicator sam æe spremiti sve 
podatke.

Kori¹tenje aplikacija
Aplikacije se pokreæu odgovarajuæim tipkama smje¹tenim na gornjem dijelu 
tipkovnice. Postoje ove aplikacijske tipke: Desk (Sustav), Tel (Telefon), Messaging 
(Poruke), , Contacts (Adresar), Calendar (Kalendar), Office (Dokumenti) i Extras 
(Razno).

Savjet: Pokrenute 
aplikacije mo¾ete odabirati 
u ‘Izborniku zadataka' na 
lijevoj strani izbornièke 
trake.

Za prijelaz na neku drugu aplikaciju ili grupu aplikacija, pritisnite odgovarajuæu 
aplikacijsku tipku. Za pokretanje neke aplikacije nije potrebno prekidati prethodnu. 
Sve aplikacije koje nisu aktivne ostaju u pozadini sve dok ih ponovo ne pokrenete.
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Slika 6

Primjer: Kad u priruèniku 
naiðete na uputu da 
'pritisnete Open (Otvori)', to 
zapravo znaèi da trebate 
pritisnuti naredbenu tipku 
uz naredbu s nazivom Open.

Osnovni elementi zaslona prikazani su na slici 6. Naredbe se uvijek odnose na èetiri 
naredbene tipke s desne strane zaslona. U priruènicima su naredbe otisnute 
podebljano, dok su stavke na zaslonu i izbornièkoj traci otisnute kurzivom.

Pomiènik pokazuje da postoji vi¹e elemenata nego ¹to ih je trenutno prikazano na 
zaslonu. Sadr¾aj na zaslonu mo¾ete pomicati pomoæu tipke sa strelicama 
smje¹tene u donjem desnom uglu tipkovnice.

Kada je pri dnu zaslona prikazano polje za pretra¾ivanje, moæi æete pomoæu 
tipkovnice unijeti tekst i na temelju njega provesti pretra¾ivanje.

Postoji li u prikazu vi¹e okvira, odabrani æe okvir biti uvijek istaknut.

Za kretanje unutar odabranog okvira te odabir pojedinih stavki, koristite tipku sa 
strelicama.

Ova je stavka 
odabrana

Desni okvir. ®elite li ga 
odabrati, pritisnite tipku Tab.

Ovaj je lijevi okvir 
odabran

Pojedinosti o stavci Naredbe koje mo¾ete 
upotrijebiti
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Pode¹avanje
Za pristup Internetu, WAP-uslugama i udaljenom po¹tanskom spremniku potrebno 
je podesiti odgovarajuæe postave. 

Opaska: Kao pomoæ u pode¹avanju navedenih postava, prouèite dokument 
'Postupak pode¹avanja' koji ste dobili u paketu s komunikatorom. Iz 
tog æete dokumenta saznati koje su vam informacije potrebne, kako do 
njih doæi te kako ih unijeti u komunikator. A ¹to je jo¹ i va¾nije, tu se 
unose podaci koji vam mogu zatrebati u buduænosti i koje æete koristiti 
za komunikaciju s davateljima usluga o onim informacijama koje od 
njih trebate dobiti.

1 Na tipkovnici komunikatora pritisnite aplikacijsku tipku Extras (Razno).
2 Tipkom sa strelicama odaberite simbol Internet startup (Internetski postavi) i 

pritisnite Open (Otvori). Nakon toga pojavit æe se tri simbola: Internet access 
(Pristup Internetu), WAP access (Pristup WAP-u) i Mail account (Raèun e-po¹te).

Savjet: Za pomoæ oko 
podataka potrebnih u ovome 
i slijedeæim dijalo¹kom 
okvirima, na tipkovnici 
pritisnite tipku  kako 
biste na zaslonu dobili 
potrebne upute; a 
pogledajte i Korisnièki 
priruènik.

3 Odaberite Internet access (Pristup Internetu) i pritisnite Open (Otvori). Otvorit æe 
se dijalo¹ki okvir.

Slika 7
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stranica, pritisnite 
izbornièku tipku.

4 Unesite potrebne podatke i pritisnite Advanced settings (Dodatni postavi). 
Otvorit æe se dijalo¹ki okvir sa èetiri stranice.

Slika 8

Na svakoj od tih stranica unesite potrebne podatke. 
Na stranici Other (Ostalo), pritisnite Address options (Adresni postavi). Otvorit 
æe se dijalo¹ki okvir.

Slika 9

Unesite IP i DNS adresu.
Za povratak u prikaz s tri simbola, pritisnite Done (Gotovo).

Savjet: Za vi¹e 
pojedinosti, vidi poglavlje 
Internet u Korisnièkom 
priruèniku.

5 Odaberite WAP access (Pristup WAP-u) i pritisnite Open (Otvori). Otvorit æe se 
dijalo¹ki okvir.
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Na svakoj od tih stranica unesite potrebne podatke, a za povratak u prikaz s tri 
simbola pritisnite Close (Zatvori).

Savjet: Za vi¹e 
pojedinosti, vidi poglavlje 
Messaging (Poruke) u 
Korisnièkom priruèniku.

6 Odaberite Mail account (Raèun e-po¹te) i pritisnite Open (Otvori). Otvorit æe se 
dijalo¹ki okvir sa èetiri stranice.

Slika 11

Na svakoj od tih stranica unesite potrebne podatke, a za povratak u prikaz s tri 
simbola pritisnite Done (Gotovo).
Opaska: Vi¹e o postavkama za Internet i po¹tu naæi æete u Korisnièkom 

priruèniku, u poglavljima Internet i Messaging (Poruke).
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Svoj komunikator mo¾ete povezati s odgovarajuæim osobnim odnosno prijenosnim 
raèunalom pomoæu programa PC Suite for Nokia 9210i Communicator koji se 
nalazi na CD-u prilo¾enom u paketu s komunikatorom. CD takoðer sadr¾i upute za 
PC Suite, i to u odjeljku Kori¹tenje Nokia 9210i Communicatora.

PC Suite for Nokia 9210i Communicator je program za osobno raèunalo koji radi 
pod operacijskim sustavima Windows 95/98, 2000 i NT. On povezuje sustav 
datoteka komunikatora sa sustavom datoteka raèunala èime vam omoguæuje brz i 
jednostavan prijenos, kopiranje, preimenovanje i brisanje datoteka i mapa na i 
izmeðu komunikatora i raèunala.

Opaska: Ne poku¹avajte instalirati niti koristiti programe PC Suite za Nokia 
9210i Communicator, PC Suite za Nokia 9210 kao ni 9290 
Communicator na istom osobnom odnosno prijenosnom raèunalu. Ako 
imate PC Suite za Nokia 9210 ili 9290 Communicator instaliran na 
svom osobnom ili prijenosnom raèunalu, prije instalacije programa PC 
Suite za Nokia 9210i Communicator morat æete ga deinstalirati

Pomoæu programa PC Suite mo¾ete izmeðu komunikatora i va¹eg raèunala 
sinkronizirati podatke iz aplikacije (podaci iz adresara ili e-poruke) te na raèunalu 
napraviti prièuvnu kopiju podataka. Osim toga, postupak sinkronizacije i stvaranja 
prièuvnih kopija mo¾ete automatizirati tako da se ti postupci obavljaju ili u 
odreðeno vrijeme ili pri uspostavi veze.

PC Suite mo¾ete koristiti i onda kad raèunalo nije povezano s komunikatorom. Kod 
svakog iduæeg povezivanja dvaju ureðaja, izmijenjene podatke mo¾ete prenijeti 
s raèunala u komunikator i obratno.
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postoji odgovarajuæa za¹tita od virusa. Vidi ’Certificate 
Management’ (Upravljanje potvrdama) u Korisnièkom 
priruèniku.

Povezivanje komunikatora s raèunalom
1 Koristite li RS-232 kabel, njegov veæi prikljuèak utaknite u serijsku (COM) 

utiènicu raèunala, a manji u utiènicu pri dnu komunikatora. 
2 Koristite li infracrveni ili serijski prikljuèak razlièit od COM1, na programskoj 

traci Windowsa dvaput pritisnite simbol programa PC Suite i odaberite 
odgovarajuæi prikljuèak.

3 Otvorite komunikator.
4 Koristite li infracrvenu vezu, pazite da infracrveni prikljuèak komunikatora bude 

okrenut prema infracrvenom prikljuèku raèunala. Za aktiviranje infracrvene 
veze na svom komunikatoru, pritisnite Chr +  (tipku s oznakom infracrvene 
veze). Vi¹e o aktiviranju infracrvene veze komunikatora naæi æete u Korisnièkom 
priruèniku.

5 Na raèunalu pokrenite program PC Suite. 
Program PC Suite trebao bi sada automatski uspostaviti vezu s komunikatorom.

Sustav (Desk)
Grupa aplikacija Desk (Sustav) koristi se za upravljanje i kori¹tenje raznih veza na 
va¹e omiljene aplikacije i programe drugih proizvoðaèa. Te veze mo¾ete stvoriti u 
odgovarajuæim aplikacijama.
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1 Otvorite stavku u odgovarajuæoj aplikaciji. 
2 Pritisnite izbornièku tipku a zatim odaberite Add to Desk (Dodaj sustavu).

Pisanje bilje¹ki
1 Pritisnite Write note (Upis bilje¹ke). Otvorit æe se jednostavni ureðivaè teksta.
2 Unesite tekst bilje¹ke.
3 Za spremanje dokumenta pritisnite Close (Zatvori). Nakon toga bilje¹ka æe se 

pojaviti u glavnom prikazu aplikacije Desk (Sustav).

Telefon (Telephone)
Telephone (Telefon) se koristi za primanje i upuæivanje govornih poziva i 
namje¹tanje postava telefona. Za pokretanje aplikacije Telefon rasklopite 
komunikator i pritisnite na tipkovnici aplikacijsku tipku Tel. Mnogo toga ¹to 
mo¾ete napraviti u aplikaciji Telefon, moæi æete napraviti i koristeæi se prednjom 
stranom komunikatora.

Za upuæivanje poziva: 
• telefon treba biti ukljuèen,
• u komunikator treba biti ulo¾ena odgovarajuæa SIM kartica i 
• morate se nalaziti u podruèju djelovanja be¾iène mre¾e.

Upuæivanje poziva
Postoje dva osnovna naèina za upuæivanje poziva:
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dotiènu osobu postoji samo jedan telefonski broj, poziv æe odmah biti upuæen.
Postoji li za tu osobu vi¹e brojeva, pojavit æe se popis svih brojeva; odaberite 
jedan od njih i pritisnite Call (Nazovi).

• U polje za pretra¾ivanje pri dnu glavnog prikaza unesite telefonski broj  i 
pritisnite Call (Nazovi).

Odgovaranje na poziv
Kada vas netko nazove, na zaslonu æe se pojaviti odgovarajuæa obavijest. Ovisno 
skupnom postavu, mo¾ete isto tako èuti i ton zvona. 

Za odgovaranje na poziv, pritisnite Answer (Odgovori) ili, 
ukoliko ne ¾elite odgovoriti, pritisnite Reject (Odbaci).

Postav za zrakoplov
Postav za zrakoplov sprjeèava nehotièno ukljuèivanje va¹eg telefona u zrakoplovu. 
Za odabir postava za zrakoplov:
1 U glavnom prikazu aplikacije Telephone (Telefon) pritisnite izbornièku tipku, a 

zatim se izbornièkom vrpcom pomièite sve dok ne doðete do simbola Profiles 
(Skupni postavi)  i odaberite Flight (Zrakoplov).

2 Pritisnite Select (Odaberi).

Dok je postav za zrakoplov ukljuèen, moæi æete obavljati one poslove za koje nije 
potrebna komunikacija s be¾iènom mre¾om. Tako æete, naprimjer, moæi èitati 
prethodno preuzetu elektronièku po¹tu, pisati e-poruke, bilje¹ke, kratke poruke, 
telefaks poruke ili obnoviti svoj kalendar. Kad izaðete iz zrakoplova, postav za 
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mo¾ete ukljuèiti telefon pritiskom na  i va¹e æe SMS poruke, telefaks poruke i 
e-poruke biti automatski odaslane.

Kad je u komunikatoru ukljuèen postav za zrakoplov, hitne pozive morat æete 
upuæivati putem telefona (uz zaklopljen komunikator) i to ovako:
1 Pritisnite . Na zaslonu telefona stajat æe poruka Flight profile is active.. (Postav 

za ZRAKOPLOV ukljuèen).
2 Dok obavijest jo¹ stoji na zaslonu (¹to traje otprilike pet sekundi), moæi æete 

birati broj hitne slu¾be uprogramiran u va¹ komunikator, naprimjer 112.
3 Pritisnite .

VA®NO! Kori¹tenje telefona u zrakoplovu zabranjeno je. Iskljuèite telefon prije 
ulaska u zrakoplov. Kori¹tenje be¾iènih telefona u zrakoplovu mo¾e 
ugroziti njegovu sigurnost, mo¾e izazvati probleme u radu mre¾e 
be¾iène telefonije, a mo¾e biti i protuzakonito. Dopusti li vam osoblje 
zrakoplova kori¹tenje raèunalnog podsustava, OBAVEZNO ukljuèite 
postav za zrakoplov. Taj vam postav dopu¹ta kori¹tenje raèunalnog 
podsustava, ali onemoguæuje kori¹tenje telefona. Ne zaboravite da je 
za sve komunikacijske aplikacije neophodno koristiti telefon.

Poruke (Messaging)
U grupu Messaging (Poruke) spadaju ove aplikacije: Fax (Telefaks), Mail 
(Elektronièka po¹ta) i SMS (Usluga kratkih poruka). Za pokretanje aplikacije 
Messaging pritisnite na tipkovnici aplikacijsku tipku Messaging.

Slanje i primanje telefaks, elektronièkih i kratkih poruka:
• telefon treba biti ukljuèen,
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• usluge za telefaks, podatke i SMS trebaju biti ukljuèene za va¹u SIM karticu,
• od davatelja internetskih usluga treba vam biti omoguæen pristup Internetu 

(IAP - Internet Access Point), a odgovarajuæi postavi za Internet i elektronièku 
po¹tu trebaju biti pode¹eni,

• broj SMS sredi¹ta treba biti upisan u postave SMS aplikacije.

Za vi¹e pojedinosti obratite se svom matiènom davatelju usluga.

Opaska: Sustav elektronièke po¹te za Nokia 9210i Communicator sukladan je 
internetskim standardima SMTP, IMAP4 i POP3.

Pisanje i slanje telefaks, elektronièkih i kratkih 
poruka
Za pisanje, izmjenu i slanje telefaks, elektronièkih i kratkih poruka koriste se 
odgovarajuæi ureðivaèi koje mo¾ete otvoriti na neki od ova tri naèina: 
• Napi¹ite i oblikujte tekst u nekoj od aplikacija koja to omoguæuje. Za slanje 

teksta, pritisnite izbornièku tipku, odaberite najprije File > Send (Datoteka > 
©alji), a zatim jednu od ponuðenih opcija slanja. 

• U glavnom prikazu aplikacije Messaging (Poruke) pritisnite jednu od ovih 
naredbi: Write fax (Pisanje telefaks poruke), Write mail (Pisanje e-poruke) ili 
Write short message (Pisanje kratke poruke).

• U glavnom prikazu aplikacije Messaging (Poruke) pritisnite izbornièku tipku i 
odaberite Write > New message (Pisanje > Nova poruka). Zatim odaberite 
odgovarajuæu vrstu poruke.
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Opaska: Za telefaks i SMS poruku mo¾ete navesti samo jednog primatelja.

Postoje dva naèina odabira primatelja va¹ih telefaks, elektronièkih i kratkih poruka.
1 U odgovarajuæem ureðivaèu za poruke pritisnite Recipient (Primatelj). Nakon 

toga otvorit æe se dijalo¹ki okvir s popisom osoba.
2 U lijevom okviru potra¾ite jednu ili vi¹e osoba i pritisnite Select (Odaberi).
3 Pritisnite Done (Gotovo).

Druga moguænost je da u zaglavlje telefaks, elektronièke ili kratke poruke 
jednostavno utipkate ime primatelja i provjerite postoji li ono u va¹em adresaru.

Primanje i èitanje telefaks i kratkih poruka
Telefaks poruke primaju se automatski, pod uvjetom da je ova usluga dostupna, da 
je telefon ukljuèen te da se nalazite u podruèju djelovanja be¾iène mre¾e. Kratke 
poruke primaju se automatski, pod uvjetom da je va¹ telefon ukljuèen.

Postoje dva naèina èitanja primljenih telefaks i kratkih poruka:
• Kad na zaslonu dobijete obavijest ili èujete zvono koje upuæuje na pristiglu 

poruku, pritisnite Open (Otvori). Zvono æe se èuti samo pod odreðenim uvjetima.
• Prijeðite u aplikaciju Messaging (Poruke). U ulaznom spremniku, odaberite 

primljenu stavku i pritisnite Open (Otvori). Telefaks odnosno kratka poruka bit 
æe otvorena odgovarajuæim preglednikom.
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Poruku koju vam netko po¹alje komunikator ne prima automatski, nego preko 
udaljenog po¹tanskog spremnika. Za èitanje poruke, najprije morate uspostaviti 
vezu s tim udaljenim po¹tanskim spremnikom, a zatim odabrati poruke za koje 
¾elite da budu prenesene u komunikator. Veza s udaljenim po¹tanskim spremnikom 
uspostavlja se preko podatkovnog poziva.

Uspostava veze s udaljenim po¹tanskim spremnikom
1 U lijevom okviru glavnog prikaza aplikacije Messaging (Poruke) odaberite 

udaljeni po¹tanski spremnik.
2 Pritisnite Retrieve mail (Preuzmi po¹tu). 
3 Nakon uspostave veze s udaljenim po¹tanskim spremnikom, pritisnite 

izbornièku tipku i odaberite Retrieve > New (Preuzmi > Nove), Selected 
(Odabrane) ili All (Sve) poruke.

4 Kada su sve e-poruke koje ste zatra¾ili preuzete, pritisnite Go offline (Prekini 
vezu).

5 Odaberite poruku koju ¾elite proèitati i pritisnite Open (Otvori).
Opaska: Postavke svog raèuna udaljenog po¹tanskog spremnika mo¾ete 

namjestiti tako da preuzima samo zaglavlja poruka. Kada dohvaæate 
po¹tu kori¹tenjem tih postavki, nakon ¹to pritisnete Open (Otvori) bit 
æe vam ponuðeno da preuzmete ostatak odabrane poruke.

UPOZORENJE! Poruke koje oznaèite kao obrisane kad niste spojeni na 
mre¾u bit æe isto tako obrisane s udaljenog poslu¾itelja 
po¹te kada ste spojeni na mre¾u. 
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Za pristup Internetu: 
• be¾ièna mre¾a koju koristite treba podr¾avati podatkovne pozive,
• usluga prijenosa podataka treba biti ukljuèena za va¹u SIM karticu,
• od davatelja internetskih usluga (ISP) treba vam biti omoguæen pristup 

Internetu (engl. IAP - Internet Access Point), i
• moraju biti uneseni odgovarajuæi internetski postavi. Slijedite odgovarajuæe 

upute u Korisnièkom priruèniku. U karticu 'Postupak pode¹avanja' koju ste 
dobili u paketu s komunikatorom upi¹ite svoje postave.

Od svog æete ISP-a dobiti upute o tome kako podesiti internetske postave. Pa¾ljivo 
slijedite upute.

Opaska: Za pristup Internetu telefon mora biti ukljuèen, morate se nalaziti u 
podruèju djelovanja mre¾e, bez glasovnih odnosno podatkovnih poziva 
u tijeku.

Za uspostavu veze s Internetom:
1 Na tipkovnici komunikatora pritisnite aplikacijsku tipku Internet.
2 Odaberite ¾eljenu aplikaciju, naprimjer WWW, i pritisnite Open (Otvori). Kad 

aplikacija treba uspostaviti vezu, otvara se dijalo¹ki okvir na kojemu stoji 
Connection name (Naziv veze) i Phone number (Broj telefona) pristupne toèke 
Internetu koju koristite za uspostavu veze. 

3 Za uspostavu veze, pritisnite OK (U redu).
4 Za zatvaranje aplikacije, pritisnite Done (Gotovo).
5 Za prekid veze s Internetom, u bilo kojoj od internetskih aplikacija, najprije na 

tipkovnici pritisnite aplikacijsku tipku Internet, a zatim Disconnect (Prekini 
vezu). Istog trenutka veza æe biti prekinuta.
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Primjer: Primjer URL adrese 
je: www.nokia.com.

WWW je sustav za pretra¾ivanje i pristup sadr¾ajima na Internetu zasnovan na 
hipertekstu. Za pregled web-stranica:

Savjet: Za pristup svojim 
stranicama, neka web-
odredi¹ta zahtijevaju 
korisnièko ime i lozinku.

1 Pritisnite izbornièku tipku i odaberite File > Open > Web page (Datoteka > Otvori 
> Web-stranicu).

2 U adresno polje unesite URL adresu ili je odaberite s popisa adresa, a zatim 
pritisnite Go to (Idi na). Do raznih web-odredi¹ta mo¾ete takoðer stiæi iz 
otvorene stranice va¹eg WWW preglednika.

3 Kod se stranica otvori, za odabir veze ili aktivnog podruèja, pritisnite tipku Tab. 
Za kretanje unatrag, koristite tipke Shift+Tab. To mo¾ete uèiniti i kori¹tenjem 
alata Pointer (Pokazivaè). Vi¹e pojedinosti o alatu Pointer naæi æete u 
Korisnièkom priruèniku.

4 ®elite li prijeæi na neku drugu stranicu ili mjesto, odaberite hipervezu odnosno 
aktivno podruèje i pritisnite Go to (Idi na).

WAP
Aplikacija za pru¾anje WAP-usluga zasnovana je na hipertekstu i koristi se za 
pristup internetskim uslugama koje nude sadr¾aje poput vijesti, vremenske 
prognoze, rasporeda letenja, rjeènika, itd. Namijenjena je mobilnim korisnicima 
s prijenosnim ureðajima.

Za pristup WAP-uslugama: 
• trebate biti unutar podruèja djelovanja mre¾e koja omoguæuje podatkovne 

pozive,
• usluga prijenosa podataka treba biti ukljuèena za va¹u SIM karticu,
• od davatelja WAP-usluga mora vam biti omoguæen pristup WAP-u, i
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u Korisnièkom priruèniku.

Kori¹tenje WAP-usluga
Otvaranje WWW stranice:
1 Pritisnite izbornièku tipku i odaberite File > Open page (Datoteka > Otvori 

stranicu). Otvorit æe se dijalo¹ki okvir. Unesite URL adresu, naprimjer: 
mobile.club.nokia.com.

2 Koristeæi tipku sa strelicama sadr¾aj mo¾ete pomicati, i u njemu odabrati 
hiperveze odnosno aktivna podruèja.
Opaska: Nekim je poslu¾iteljima pristup ogranièen i zahtijeva ispravno 

korisnièko ime i lozinku. U tom æe sluèaju, prije pristupa odreðenoj 
usluzi od vas biti zatra¾eno da unesete svoje korisnièko ime i lozinku.

Adresar (Contacts)
Za pokretanje aplikacije Contacts, pritisnite na tipkovnici aplikacijsku tipku 
Contacts. Aplikacija Contacts namijenjena je za stvaranje, ureðivanje i voðenje 
podataka o osobama, kao ¹to su njihovi brojevi telefona i adrese. Stavke u imeniku 
Contacts nazivaju se posjetnice. Te podatke mo¾ete sinkronizirati s podacima na 
odgovarajuæem raèunalu. Za vi¹e pojedinosti o sinkronizaciji podataka, potra¾ite 
PC Suite Guide (Vodiè za PC Suite) koji se nalazi na CD-u koji ste dobili zajedno s 
komunikatorom.

Glavna baza adresara smje¹tena je u memoriji komunikatora. Podatke o osobama 
mo¾ete spremiti i u odvojene baze podataka na prikljuèenoj memorijskoj kartici.
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1 U glavnom prikazu aplikacije Contacts, pritisnite New card (Nova posjetnica).
2 Kad se posjetnica otvori, u odgovarajuæa polja unesite podatke.
3 Za spremanje posjetnice, pritisnite Done (Gotovo).

Pozivanje osobe s posjetnice
Glavni prikaz aplikacije Contacts sastoji se od dva okvira, lijevog i desnog. Za 
prijelaz u desni okvir pritisnite Tab. Oznaèite broj telefona dotiène osobe i pritisnite 
Call (Nazovi).

Kalendar (Calendar)
U aplikaciji Calendar (Kalendar), moæi æete provjeriti planirane dogaðaje, sastanke, 
godi¹njice, roðendane, kao i popis poslova koje trebate obaviti. Svim stavkama u 
kalendaru mo¾ete pridru¾iti alarm. Za pokretanje aplikacije Calendar, na tipkovnici 
komunikatora pritisnite aplikacijsku tipku Calendar.

Svoj kalendar i zadatke mo¾ete sinkronizirati s programima Microsoft Windows i 
Lotus, kad svoj komunikator prikljuèite na osobno raèunalo. Za vi¹e pojedinosti o 
sinkronizaciji, potra¾ite PC Suite Guide (Vodiè za PC Suite) koji se nalazi na CD-u 
koji ste dobili zajedno s komunikatorom.

Stvaranje stavke u kalendaru
Jedan naèin stvaranja nove stavke u kalendaru jest:
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Odaberite vrstu stavke koju ¾elite stvoriti: Appointment (Sastanak), Event 
(Dogaðaj), Anniversary (Godi¹njica) ili Task (Zadatak).

2 U polja stranica dijalo¹kog okvira unesite odgovarajuæe podatke.

Mjeseèni prikaz (Month view)
Mjeseèni prikaz glavni je prikaz Kalendara. Ukoliko ste u Calendar unijeli podatke 
za odreðeni mjesec, na desnoj strani zaslona vidjet æete popis dogaðaja. Za izmjenu 
dogaðaja:
1 Pritisnite tipku Enter ili Edit day (Izmjena u danu) kako biste pre¹li u desni okvir.
2 Odaberite dogaðaj i pritisnite Edit (Izmjena). Pojavit æe se obrazac 

s pojedinostima.
3 Ako je potrebno, izmijenite podatke za tu stavku.

Tjedni prikaz (Week view)
Tjedni prikaz sadr¾i raspored dogaðaja za odabrani tjedan. Za odabir tjednog 
prikaza, pritisnite Change view (Promjena prikaza) i odaberite Week (Tjedan).

Dnevni prikaz (Day view)
Dnevni prikaz sadr¾i popis stavaka za odabrani dan. Za odabir dnevnog prikaza, 
pritisnite Change view (Promjena prikaza) i odaberite Day (Dan). 
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U tom prikazu mo¾ete vidjeti jedan popis poslova. Ovakve popise mo¾ete koristiti 
za voðenje podataka o svojim poslovima. Mo¾ete odreðivati rokove i prioritete 
svojih poslova. Takvih popisa mo¾ete imati vi¹e, primjerice, jedan koji se odnosi na 
poslovne, a drugi na privatne obveze. 

Ostali prikazi (Other views)
Komunikator sadr¾i i ostale prikaze, kao ¹to su Yearly planner schedule (Godi¹nji 
plan) i Anniversary schedule (Popis godi¹njica).

Dokumenti (Office)
Office (Dokumenti) sadr¾i ove aplikacije: Word Processor (Tekst), Sheet (Tablice), 
Presentation viewer (Preglednik prezentacija) i File manager (Rukovatelj 
datotekama), a sve su one uskladive s operacijskim sustavom Microsoft Windows.

Stvaranje Word Processor dokumenta
Kad otvorite aplikaciju Word Processor (Tekst), bit æe otvoren novi dokument. 
Odmah mo¾ete zapoèeti s pisanjem.

Za spremanje dokumenta, pritisnite Close (Zatvori). Otvorit æe se dijalo¹ki okvir. 
Sada trebate imenovati dokument i odabrati mapu u koju ga ¾elite spremiti.
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Pomoæu aplikacije Sheet (Tablice) mo¾ete raditi s podacima i spremati ih u 
datoteku koja se naziva radna knjiga. Svaka radna knjiga sadr¾i barem jedan radni 
list. Osim toga, radna knjiga mo¾e sadr¾avati i grafikonske listove. Grafikonski list 
je dokument koji sadr¾i grafikon temeljen na podacima iz radnoga lista.

Stvaranje radnih knjiga i radnih listova
Savjet: Za dodavanje 

radnog lista u aplikaciju 
Desk (Sustav), pritisnite 
izbornièku tipku i odaberite 
File > Add to Desk (Datoteka 
> Dodaj sustavu).

Za stvaranje nove radne knjige, pritisnite izbornièku tipku i odaberite File > New 
workbook (Datoteka > Nova radna knjiga).

Za spremanje radne knjige, u prikazu s radnim listom pritisnite izbornièku tipku i 
odaberite File > Save (Datoteka > Spremi).

Za stvaranje novog radnog lista u radnoj knjizi, pritisnite izbornièku tipku i 
odaberite Insert > New worksheet (Umetni > Novi radni list).

Za unos podataka, tipkom sa strelicama najprije odaberite æeliju, a zatim u nju 
poènite unositi podatke.

Kao potvrdu upisa u æeliju, pritisnite Enter, OK (U redu) ili tipkom sa strelicama 
prijeðite na neku drugu æeliju. ®elite li poni¹titi upis, pritisnite Esc ili Cancel 
(Odustani).

Za odreðivanje kategorije kojoj ¾elite da pripada podatak u æeliji, pritisnite 
Function (Funkcija). Postoje ove kategorije: All (Sve), Financial (Financijske), Date 
and time (Datumske i vremenske), Mathematical (Matematièke), Statistical 
(Statistièke), Lookup (Pretra¾ivaèke), Text (Tekstovne), Logical (Logièke) i Information 
(Informacijske). Svakoj od navedenih kategorija pripada odreðeni skup funkcija 
koje mo¾ete vidjeti na popisu uz Function name (Naziv funkcije).
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Postoji sedam razlièitih vrsta grafikona: Column (Stupèasti), Stacked column 
(Vi¹eslojni stupèasti), Line (Linijski), Pie (Kru¾ni), Bar (©tapiæasti), Stacked bar 
(Vi¹eslojni ¹tapiæasti) i X/Y scatter (Obièni X/Y).
1 Odaberite podruèje na radnome listu. Podaci iz tog podruèja koristit æe se za va¹ 

novi grafikonski list.
2 Pritisnite izbornièku tipku i odaberite Insert > New chart (Umetanje > Novi 

grafikon). Otvorit æe se dijalo¹ki okvir.
3 Potrebno je odrediti slijedeæe: Chart name (Naziv grafikona), Chart type (Vrsta 

grafikona), 3-D (3D-prikaz), Background colour (Boja pozadine) i Axis colour (Boja 
osi).

4 Za stvaranje novog grafikonskog lista, pritisnite Close (Zatvori), a za 
odustajanje Cancel (Odustani).

Preglednik prezentacija (Presentation viewer)
Za otvaranje prezentacije, u glavnom prezentacijskom prikazu pritisnite Open 
(Otvori) kako biste odabrali i pregledali dokument. Za zatvaranje aplikacije, 
pritisnite Close (Zatvori).

Savjet: Radi boljeg 
prikaza, prezentaciju mo¾ete 
uveæati odnosno umanjiti.

Nakon otvaranja dokumenta, bit æe prikazan gornji dio prvog slajda. Za prikaz 
sljedeæeg slajda, pritisnite Next (Sljedeæi) ili Enter. Za prikaz prethodnog slajda, 
pritisnite Previous (Prethodni). Za pomicanje tekuæeg slajda, koristite tipku sa 
strelicama.



Copyright © 2000-2002 Nokia. All rights reserved.

29

Za
 p

oè
et

akRukovatelj datotekama (File manager)
File manager (Rukovatelj datotekama) koristi se za rad sa sadr¾ajem i svojstvima 
raznih mapa.

U okviru mape, stablo mo¾e sadr¾avati mape koje pripadaju dvjema korijenskim 
mapama: komunikatora i memorijske kartice. 

U korijenskoj mapi komunikatora nalazi se mapa C:\Documents\ (Dokumenti) koja 
sadr¾i èetiri gotove mape: \Documents\Downloaded\ (Preuzeto), \Documents\Photo 
gallery\ (Foto zbirka), \Documents\Templates\ (Predlo¹ci) i \Documents\Tones\ 
(Tonovi).

U okviru datoteka prikazane su sve datoteke koje se nalaze u mapi trenutno 
oznaèenoj u lijevom okviru. Naziv popisa datoteka pokazuje put do trenutno 
odabrane datoteke. Okvir s popisom datoteka pokazuje i simbol odgovarajuæe 
aplikacije te naziv i datum zadnje promjene datoteke. Datoteke su poredane 
abecednim redom.

Prikaz sadr¾aja mape
1 U lijevom okviru sa stablom mapa odaberite ¾eljenu mapu i pritisnite Open 

(Otvori). 
U prikazu æe se pojaviti sve podmape i datoteke koje pripadaju odabranoj mapi.

2 Za prikaz podmapa ni¾e razine, odaberite mapu i pritisnite Open (Otvori).
3 Za povratak u glavni prikaz, pritisnite Done (Gotovo).

Otvaranje datoteke
1 Odaberite datoteku i pritisnite Open (Otvori). Nakon toga datoteka æe biti 

otvorena u odgovarajuæoj aplikaciji.
2 Za povratak u glavni prikaz, pritisnite Close folder (Zatvori mapu).
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1 U glavnom prikazu aplikacije File manager pritisnite izbornièku tipku i odaberite 
File > New folder (Datoteka > Nova mapa). Otvorit æe se dijalo¹ki okvir. 

2 Imenujte novu mapu.

Tra¾enje datoteka i mapa
1 Odaberite mapu ili memoriju u kojoj ¾elite provesti pretra¾ivanje.
2 Pritisnite izbornièku tipku > Tools > Find (Alati > Pretra¾ivanje). Otvorit æe se 

dijalo¹ki okvir. 
3 U polje utipkajte tekst na temelju kojega ¾elite provesti pretra¾ivanje. 
4 Za pobli¾e odreðivanje naèina pretra¾ivanja, pritisnite Options (Dodaci).

Za promjenu vrijednosti stavke s popisa, pritisnite Change (Promijeni). 
Kad ste spremni, pritisnite Close (Zatvori).

5 Za pokretanje pretra¾ivanja, pritisnite Find (Naði).
Za zaustavljanje pretra¾ivanja, pritisnite Stop (Stani).

6 Po zavr¹etku pretra¾ivanja, pritisnite Open (Otvori) kako biste otvorili 
pronaðenu mapu odnosno datoteku.
Za pokretanje novog pretra¾ivanja, pritisnite New find (Naði iznova).

7 Za povratak u glavni prikaz, pritisnite Close (Zatvori).

Razno (Extras)
Na tipkovnici pritisnite aplikacijsku tipku Extras kako biste vidjeli razne aplikacije. 
Za pokretanje aplikacije, odaberite je pomoæu tipke sa strelicama, a zatim pritisnite 
Open (Otvori). 
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aplikacije.

Sat (Clock)
Clock (Sat) pokazuje vrijeme i datum u va¹em gradu i zemlji, kao i u nekoliko drugih 
gradova i zemalja odnosno regija ¹irom svijeta. Aplikacija Clock ukljuèuje i sat za 
alarm.

Namje¹tanje alarma
Savjet: U aplikaciji 

Calendar (Kalendar) mo¾ete 
isto tako namjestiti alarm.

1 U glavnom prikazu aplikacije Clock, pritisnite Alarm clock (Sat za alarm). 
Otvorit æe se prikaz sata za alarm.
Trenutno aktivni alarmi nalaze se na popisu pored sata.

2 Za stvaranje novog alarma, pritisnite New alarm (Novi alarm).
Za izmjenu alarma, pritisnite Edit alarm (Izmjena alarma).
Otvorit æe se dijalo¹ki okvir.

3 Navedite podatke potrebne za alarm kao ¹to je Time (Vrijeme).
4 Za prihvaæanje namje¹tenog alarma, pritisnite Close (Zatvori).

Iskljuèivanje zvuka alarma
Pritisnite Stop (Stani) ili bilo koju drugu tipku na tipkovnici telefona.

Za uti¹avanje alarma na neko vrijeme, pritisnite Snooze (Prièekaj).

Kalkulator (Calculator)
Calculator (Kalkulator) mo¾e raditi na dva naèina: kao stolni kalkulator za 
jednostavne aritmetièke operacije ili kao znanstveni kalkulator za slo¾enije 
matematièke operacije.
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ili odabirom simbola iz popisa funkcija. Izraèun se provodi pritiskom na tipku Enter 
ili =. Izraèun i rezultat mogu se vidjeti na izlaznom listu s lijeve strane zaslona. Za 
prijelaz izmeðu polja za unos, izlaznog lista i popisa funkcija, pritisnite tipku Tab ili 
Change focus (Promijeni fokus).

Odrednik (Control panel)
U Control panelu (Odredniku) mo¾ete vidjeti i mijenjati: Security (Sigurnost), Data 
call barring (Zabrana podatkovnih poziva), Accessories (Dodatni pribor), Profiles 
(Skupni postavi), Display (Prikaz), Certificate manager (Upravitelj za potvrde), Date 
and time (Datum i vrijeme), Install/Remove software (Instaliranje/deinstaliranje 
programa), Internet access (Pristup Internetu), About product (Informacije o 
proizvodu), Memory (Memorija), Regional settings (Regionalni postavi) i Default 
folder (Poèetna mapa).

Izmjene ovih znaèajki utjecat æe na rad komunikatora u svim aplikacijama.

Za otvaranje programa za izmjenu, pomoæu tipke sa strelicama odaberite 
odgovarajuæi simbol i pritisnite Open (Odaberi).

Snimaè (Recorder)
Savjet: Pomoæu Snimaèa 

(Recorder) mo¾ete snimati 
zvukove i govor, i koristiti ih 
kao tonove zvona. Za vi¹e 
pojedinosti vidi Korisnièki 
priruènik.

Recorder (Snimaè) vam omoguæuje snimanje telefonskih razgovora i govornih 
zabilje¹ki. Isto tako omoguæuje vam preslu¹avanje i izmjenu snimljenog zapisa i 
ostalih zvukovnih datoteka.
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Slika 12

Ukljuèivanje telefona
1 Ako je ureðaj rasklopljen, zaklopite ga.
2 Za ukljuèivanje telefona pritisnite i dr¾ite . 

Zatra¾i li se od vas PIN kod, unesite PIN kod koji ste dobili zajedno sa SIM karticom 
i pritisnite tipku  smje¹tenu odmah ispod teksta na zaslonu ‘OK’ (U redu). 

Telefon

Slu¹alica

Sprijeda Straga

Mikrofon
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zabranjena ni onda kada mo¾e prouzroèiti smetnje ili opasnost.

Oznake na zaslonu
Oznake na zaslonu obavje¹tavaju vas o tome ¹to se u telefonu trenutno zbiva. Ni¾e 
opisane oznake vrijede za telefon koji je spreman za uporabu, s tim da korisnik jo¹ 
ni¹ta nije unosio.

NAZIV ili LOGOTIP MRE®E 

- Pokazuje koju mre¾u be¾iène telefonije va¹ telefon trenutno koristi.

 i ¹tapiæi iznad ovog simbola.

- Pokazuje trenutnu jakost signala na mjestu na kojem se nalazite. ©to je broj 
¹tapiæa veæi, to je signal bolji.

 i ¹tapiæi iznad ovog simbola.

- Pokazuje stanje napunjenosti baterije. ©to je broj ¹tapiæa veæi, to je baterija 
punija.

Vi¹e o oznakama na zaslonu naæi æete u Korisnièkom priruèniku, u poglavlju Phone 
(Telefon).

Upuæivanje i odgovaranje na poziv
Za upuæivanje poziva, unesite pozivni broj i broj telefona, a zatim pritisnite .

Za javljanje na poziv pritisnite .

Za prekid veze pritisnite . 
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Za prijelaz izmeðu skupnih postava.

 Za listanje izbornika, podizbornika i postava. Ako nema aktivnih 
poziva, tipke za pomicanje mo¾ete koristiti za listanje sadr¾aja memorije. Kad je 
poziv u tijeku, tipke za pomicanje koriste se za ugaðanje glasnoæe.

 do  Brojevne i slovne tipke. Za pozivanje svog spremnika glasovnih 
poruka, pritisnite i dr¾ite . 

 Koristi se za posebne funkcije. Ako ste pretplaæeni na dvije telefonske 
linije, s jedne na drugu mo¾ete prelaziti pritiskom i dr¾anjem tipke . 

 Funkcija ovih dviju vi¹enamjenskih tipki mijenja se u skladu s tekstom 
u donjem dijelu zaslona.

Opaska: Slu¹alica i mikrofon nalaze se na stra¾njoj strani ureðaja.

Forum Nokia
Nokia Wireless Data Forum je web-usluga za one koji se bave razvojem aplikacija 
i usluga za Nokijine platforme. Ove web-stranice pru¾aju informacije o raznim 
razvojnim moguænostima poput programa marketin¹ke potpore razvojnim 
timovima, sistem integratorima i ostalim Nokijinim partnerima.

Osim toga, Nokia Wireless Data Forum pru¾a potporu za Nokia 9210i 
Communicator kao i ostale Nokijine be¾iène ureðaje za prijenos podataka. 
Web-stranice sadr¾e dokumente, upravljaèke programe, kratke priruènike, podatke 
o kompatibilnosti itd.
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web-stranice sadr¾e dokumente o raznim tehnologijama be¾iènog prijenosa 
podataka.

Nokia Wireless Data Forum mo¾ete naæi na adresi http://www.forum.nokia.com

Club Nokia
Club Nokia pomoæi æe vam da svoj Nokia telefon iskoristite ¹to bolje. Kao èlan 
Cluba Nokia, ostvarujete èitav niz ekskluzivnih pogodnosti. Tu spadaju brza usluga 
i potpora, prikazi novih Nokijinih proizvoda, posebne ponude, pristup 
web-stranicama Club Nokia i jo¹ mnogo toga.

Imate li kakvih pitanja, pomoæi æe vam netko od struènjaka za Nokia telefone. 
Omoguæen vam je i jednostavan pristup telefonskoj slu¾bi za potporu Club Nokia 
Careline. Osim toga omoguæen vam je jednostavan pristup do Club Nokia Instant 
Service, na¹eg jedinstvenog uslu¾nog centra za registrirane èlanove Cluba Nokia. 
Uslu¾ne punktove Cluba Nokia mo¾ete naæi diljem Europe. 

Svim uslugama Cluba Nokia, informacijama o proizvodima, posebnoj ponudi, 
novitetima i nagradnim igrama mo¾ete br¾e i lak¹e pristupiti putem web-stranica 
Cluba Nokia. Club Nokia dostupan je u veæini europskih zemalja - postanite 
njegovim èlanom veæ danas. Club Nokia naæi æete na adresi 
http://www.club.nokia.com.
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pribor

Savjet: Originalni Nokijin 
dodatni pribor pokriva 
¹iroku lepezu razlièitih 
uvjeta kori¹tenja: dodatnu 
opremu za prijenos 
podataka, praktiène 
naglavne slu¹alice te 
punjaèe i dr¾aèe za mobilno 
kori¹tenje, ali i za kori¹tenje 
u uredu.

Originalni Nokijin dodatni pribor osigurava najbolje funkcioniranje va¹eg 
pokretnog telefona Nokia u razlièitim prilikama. Dodatni pribor za Nokia 9210i 
Communicator prilagoðen je raznim tipovima korisnika i raznim komunikacijskim 
potrebama.

Opaska: Koristite samo one baterije, punjaèe i dodatni pribor koji su za ovaj 
model odobreni od proizvoðaèa komunikatora. Kori¹tenjem drugih 
modela prestat æe va¾iti svaki atest odnosno jamstvo za komunikator, 
a osim toga to mo¾e biti i opasno.
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Baterija velikog kapaciteta BLL-3

Slika 13

Baterija velikog kapaciteta BLL-3 tanka je, sna¾na i trajna litij-ionska baterija od 
1300 mAh. Ova vam baterija, ovisno o naèinu kori¹tenja, omoguæuje 4-10 sati 
razgovora te 80-230 sati u stanju èekanja.

Nokia 9210i Communicator zajedno s baterijom te¾i 244 g.
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Slika 14

Savjet: Ovaj je punjaè 
posebno prikladan za one 
koji dosta putuju.

Brzi punjaè ACP-12 lagani je i trajni punjaè koji radi s veæinom izvora napajanja 
razlièitih napona. Za vrijeme punjenja komunikator mo¾ete koristiti na uobièajeni 
naèin. Kori¹tenjem ovog punjaèa, punjenje komunikatora traje otprilike 180 
minuta (ovisno o stanju napunjenosti baterije).

Opaska: Sa svojim komunikatorom mo¾ete koristiti i Brzi punjaè ACP-9

Europska izvedba Izvedba za Veliku 
Britaniju
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Savjet: Za punjenje 
baterija pomoæu ovog stalka 
potreban vam je brzi punjaè 
ACP-9. Za povezivanje 
s raèunalom potreban vam 
je RS-232 prikljuèni kabel 
DLR-2L. Vezu s raèunalom 
mo¾ete ostvariti i be¾iènim 
putem.

Slika 15

Pro¹ireni stolni stalak DCH-10 omoguæuje jednostavano
• punjenje baterije kada je ona prikljuèena na komunikator,
• povezivanje na odgovarajuæe raèunalo radi prijenosa podataka.

Na lijevoj strani stalka nalazi se infracrveni prikljuèak (vidi sliku 15). Stalak ima i 
utor za punjenje baterija izvaðenih iz komunikatora, ¹to predstavlja posebnu 
pogodnost za punjenje prièuvnih baterija. 

Punjenje baterije u komunikatoru pomoæu stolnog stalka
1 Na stalak prikljuèite brzi punjaè ACP-9.
2 Komunikator s baterijom i prikljuèkom prema dolje najprije umetnite u stolni 

stalak.
3 Prikljuèite punjaè na zidnu utiènicu.

utor za punjenje 
prièuvne baterije

infracrveni 
prikljuèak
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1 Na stolni stalak prikljuèite brzi punjaè.
2 Prièuvnu bateriju s pozlaæenim prikljuècima okrenutim prema dolje umetnite u 

drugi utor. Najprije bateriju pritisnite prema dolje i lagano je gurnite prema 
natrag dok ne ¹kljocne i sjedne na svoje mjesto.

3 Prikljuèite punjaè na zidnu utiènicu. Lampica na lijevoj strani punjaèa treba biti 
upaljena. Crveno svjetlo oznaèava da proces punjenja jo¹ traje. Kad se baterija 
napuni, pojavit æe se zeleno svjetlo.

4 Izvadite bateriju tako da je gurnete prema naprijed i podignete sa stalka.
Opaska: Ako se na stalku nalazi i komunikator, tada æe punjenje prièuvne 

baterije biti prekinuto sve dok baterija u komunikatoru ne bude 
potpuno napunjena.

Povezivanje s raèunalom
Za povezivanje s raèunalom koristite RS-232 prikljuèni kabel DLR-2L, i to ovako:
1 Jedan kraj kabela utaknite u prikljuèak na stra¾njoj strani stalka.
2 Drugi kraj kabela spojite na raèunalo. 
3 Komunikator s prikljuèkom prema dolje umetnite u stalak.
4 Na raèunalu pokrenite program PC Suite for Nokia 9210i Communicator ili 

aplikaciju Fax/Modem (Telefaks/Modem).

Osim kabelske mo¾ete koristiti i infracrvenu vezu, i to ovako:
1 Provjerite je li infracrvena veza ukljuèena na komunikatoru i na raèunalu. 
2 Komunikator s prikljuèkom prema dolje umetnite u stalak.
3 Infracrveni prikljuèak stalka usmjerite prema infracrvenom prikljuèku raèunala. 

Udaljenost izmeðu dva prikljuèka ne bi smjela prelaziti 30 cm.
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aplikaciju Fax/Modem (Telefaks/Modem).

Podatke izmeðu svog komunikatora i odgovarajuæeg programa na raèunalu mo¾ete 
sinkronizirati jednim pritiskom tipke . Vi¹e pojedinosti naæi æete u Uputama za 
PC Suite (odjeljak Kori¹tenje Nokia 9210i Communicatora) koje se nalaze na CD-u 
koji ste dobili zajedno s komunikatorom.
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Pro¹irena instalacija za automobil CARK109

Slika 16

Savjet: Vrijeme punjenja 
baterije isto je kao kod brzog 
punjaèa ACP-9.

Pro¹irena instalacija za automobil CARK109 omoguæuje kori¹tenje komunikatora u 
automobilu bez uporabe ruku. Instalacija za automobil omoguæuje punjenje va¹eg 
komunikatora. Ugradnju opreme u automobil treba obaviti struèna osoba. 
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Slika 17

Instalacija se sastoji od pro¹irenog aktivnog dr¾aèa CRM-1 (prikazan na slici 17), 
pro¹irene jedinice za rad slobodnih ruku HFU-2, mikrofona HFM-8 i vanjskog 
zvuènika HFS-12. Osim toga, za razgovor u diskreciji mo¾ete koristiti i dodatnu 
slu¹alicu HSU-1, a za bolji prijam i rad antenu AMD-2 (oba se ova dodatka mogu 
nabaviti posebno). 

Stavljanje komunikatora na dr¾aè
1 Zaklopite komunikator i zakrenite antenu u zatvoren polo¾aj.
2 Komunikator s prikljuèkom prema dolje umetnite u dr¾aè.
3 Pazeæi da ne o¹tetite prikljuèke, pritisnite komunikator lagano prema dolje sve 

dok ga prihvatni mehanizam ne uèvrsti.

Upuæivanje poziva iz vozila
1 ®eljeni broj utipkajte preko tipkovnice ili, pak, taj broj odnosno ime potra¾ite 

koristeæi funkciju pretra¾ivanja.
2 Pritisnite . Za diskretan razgovor podignite slu¹alicu, ako je ugraðena.

Odgovaranje na poziv
1 Pritisnite , ili, ako je ugraðena slu¹alica, podignite ju.
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dolazne pozive automatski odgovoriti.

Prebacivanje razgovora preko slu¹alice na razgovor bez uporabe 
ruku
Pritisnite jednom tipku Options (Opcije) i u roku od 5 sekundi vratite slu¹alicu na 
mjesto. Ne pritisnete li Options (Opcije) prije vraæanja slu¹alice, veza æe biti 
prekinuta.

Prekid razgovora
Pritisnite , ili, ako je ugraðena slu¹alica, vratite je na mjesto.

Kontakt pri paljenju
Kontakt pri paljenju omoguæuje da se komunikator, dok se nalazi na dr¾aèu, 
automatski ukljuèuje i iskljuèuje ovisno o tome je li vozilo upaljeno ili nije. Time je 
izbjegnuta moguænost da komunikator isprazni akumulator automobila, dogodi li 
se da sluèajno ostaje ukljuèen na dulje vrijeme.

Kad je moguænost kontakta pri paljenju jednom ugraðena, ona postaje trajna. Ne 
¾elite li ovakvu pogodnost, zatra¾ite od dobavljaèa da je ne ugraðuje.

Kad ugasite automobil na zaslonu æe se pojaviti obavijest ‘Phone will power off, if 
not used’ (Ako ga ne koristite, telefon æe biti iskljuèen). Komunikator æe biti 
iskljuèen za 15 sekundi, ako u tom vremenu ne pritisnete neku tipku ili ne izvadite 
komunikator iz dr¾aèa.
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Omoguæuje uti¹avanje auto-radija za vrijeme trajanja telefonskog poziva, ako va¹ 
auto-radio podr¾ava takvu moguænost. Pri ugradnji, od svog dobavljaèa zatra¾ite 
ukljuèenje navedene opcije.

Upravljanje motorom antene
Kad je ova opcija ugraðena, ukljuèivat æe elektromotor pokretne antene.

Punjaè na upaljaè za cigarete LCH-9

Slika 18

Punjaè na upaljaè za cigarete LCH-9 omoguæuje jednostavan i prikladan naèin 
punjenja baterije komunikatora u vozilu. Prikladan je za veæinu upaljaèa za 
cigarete. Izvod iz punjaèa utaknite u utiènicu pri dnu komunikatora.
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Naglavna slu¹alica HDC-8L

Slika 19

Naglavna slu¹alica HDC-8L omoguæuje razgovor u diskreciji. Daljinskom 
upravljaèkom tipkom, smje¹tenom na mikrofonskom dijelu naglavnih slu¹alica 
mo¾ete odgovoriti na poziv odnosno prekinuti razgovor. Slu¹alice se prikljuèuju na 
utiènicu smje¹tenu u donjem dijelu komunikatora.
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Slika 20

Torbica je posebno dizajnirana za Nokia 9210i Communicator. Mo¾ete je nabaviti 
kod Nokijinih dobavljaèa.

Pokretni ured
Memorijska kartica
Memorijska kartica velièine po¹tanske marke nudi izmjenjivu memoriju za va¹ 
komunikator. Memorijskom karticom poveæava se raspolo¾iva kolièina memorije za 
podatke i programe. Na taj æete naèin u komunikator moæi uèitati nove aplikacije 
i spremiti datoteke koje sadr¾e slike, zvuk u wav zapisu, faksove i dokumente. 
Memorijsku karticu moæi æete koristiti i za razlièite aplikacije ili adresare.

Opaska: Memorijske kartice za Nokia 9210i Communicator ne mogu se koristiti 
u starijim modelima Nokijinih komunikatora, meðutim, kartice za 
Nokia 9110i Communicator se nakon formatiranja mogu koristiti u 
modelu 9210i.
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Slika 21

Ovaj prilagodljivi prikljuèni kabel omoguæuje vam da za prijenos podataka 
jednostavno svoj Nokia 9210i Communicator pove¾ete s raèunalom. Prikljuèuje se 
na RS-232 serijski prikljuèak odgovarajuæeg raèunala. Mo¾e se koristiti i 
s pro¹irenim stolnim stalkom DCH-10.
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)3. Certifikat o brzini 
apsorpcijske doze (SAR)
OVAJ MODEL TELEFONA UDOVOLJAVA DR®AVNIM PROPISIMA O IZLO®ENOSTI 
RADIO VALOVIMA

Va¹ je komunikator, kao i svaki drugi prijenosni telefon, radiopredajnik i 
radioprijamnik. Projektiran je i izveden tako da ne prijeðe razinu emitirane energije 
radiofrekventnog (RF) zraèenja koja vrijedi kao meðunarodna preporuka (ICNIRP). 
Ta su ogranièenja dio opse¾nih smjernica koje utvrðuju dopu¹tene razine energije 
RF zraèenja za ¹iru populaciju. Smjernice su sastavile neovisne znanstvene 
organizacije kroz vi¹estruke i iscrpne analize rezultata znanstvenih istra¾ivanja. 
Smjernice sadr¾e dovoljno veliku mjeru sigurnosti radi za¹tite svih ljudi, neovisno 
o njihovoj dobi i zdravstvenom stanju.

Standard o izlo¾enosti zraèenju za prijenosne telefone koristi mjernu jedinicu 
poznatu pod nazivom brzina apsorpcijske doze (engl. SAR). Ogranièenje brzine 
apsorpcijske doze utvrðeno u meðunarodnim smjernicama iznosi 2.0 W/kg*. 
Ispitivanja brzine apsorpcijske doze provedena su za uobièajene radne polo¾aje pri 
èemu telefon emitira s najveæom dopu¹tenom snagom na svim ispitivanim 
frekvencijama. Iako je brzina apsorpcijske doze utvrðena uz najvi¹u razinu 
potvrðene snage, stvarna brzina apsorpcijske doze pri kori¹tenju telefona mo¾e biti 
znatno ispod najveæe vrijednosti. To je stoga ¹to je telefon projektiran tako da radi 
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Opæenito, ¹to ste bli¾i baznoj stanici, telefonu æe biti potrebna manja izlazna 
snaga.

Najveæa vrijednost brzine apsorpcijske doze (SAR) modela Nokia 9210i 
Communicator pri ispitivanju o udovoljavanju standardu bila je 0.34 W/kg. Dok 
meðu raznim telefonima i u raznim polo¾ajima mo¾e postojati razlika u 
vrijednostima brzine apsorpcijske doze, sve te vrijednosti u skladu su s 
odgovarajuæim meðunarodnim smjernicama o izlo¾enosti RF zraèenju.

* Ogranièenje brzine apsorpcijske doze za prijenosne telefone u opæoj uporabi 
iznosi 2.0 vata po kilogramu (W/kg) usrednjeno na deset grama tjelesnog tkiva. Ove 
smjernice sadr¾e dovoljno veliku mjeru sigurnosti radi dodatne za¹tite ljudi, a 
uzimaju u obzir i moguæe varijacije u mjerenjima.Brzine apsorcijskih doza mogu 
odstupati zbog razlièitih nacionalnih propisa o sastavljanju izvje¹æa kao i zbog 
frekvencije mre¾e. Pojedinosti o brzinama apsorpcijskih doza u ostalim regijama 
sastavni su dio informacija o proizvodu i mo¾ete ih naæi na adresi http://
www.nokia.com.
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OGRANIÈENA GARANCIJA PROIZVOÐAÈA

ZA DIO EUROPSKE I AFRIÈKE REGIJE
Ova ogranièena garancija Nokia Mobile Phones primjenjivat æe se u onom dijelu 
europske i afrièke regije za koje ne postoji lokalna garancija. Nokia Corporation, Nokia 
Mobile Phones ("Nokia") garantira pod sljedeæim uvjetima i kondicijama da ovaj 
proizvod NOKIE ("Proizvod") u trenutku osnovne kupnje nema nedostataka u pogledu 
materijala, dizajna i izrade:
1. Ova ogranièena garancija izdaje se krajnjem kupcu Proizvoda ("Kupac"). Ona ne 

iskljuèuje niti ogranièava i) mandatorna zakonska prava Kupca ili ii) prava Kupca 
protiv prodavatelja/distributera Proizvoda.

2. Garantni rok iznosi dvanaest (12) mjeseci od datuma kupnje Proizvoda od strane 
prvog Kupca. U sluèaju naredne kupnje ili promjene vlasnika/korisnika, garantni 
rok se nastavlja za preostali dio razdoblja od dvanaest (12) mjeseci, te u drugom 
ostaje neizmijenjen. Ova ogranièena garancija va¾i i izvr¹iva je iskljuèivo u 
sljedeæim zemljama: Bosni, Bugarskoj, Hrvatskoj, Cipru, Èe¹koj Republici, 
Estoniji, dr¾avama èlanicama Europske Unije, Maðarskoj, Islandu, Izraelu, Latviji, 
Litvi, Makedoniji, Malti, Norve¹koj, Poljskoj, Rumunjskoj, Slovaèkoj Republici, 
Sloveniji, ©vicarskoj i Turskoj.

3. Za trajanja garantnog roka, prema slobodnoj procjeni Nokie, Nokia ili ovla¹teni 
servis popravit æe ili zamijeniti defektni Proizvod. Nokia æe popravljeni Proizvod 
ili drugi Proizvod vratiti Kupcu u ispravnom stanju. Svi dijelovi ili druga oprema 
koja je zamijenjena postaju imovina Nokie.

4. Za popravljeni ili zamijenjeni Proizvod ne odobrava se produljenje ili obnavljanje 
garantnog roka.

5. Ova ogranièena garancija ne obuhvaæa poklopce u boji ili druge sliène dijelove. 
U sluèaju kada treba otkljuèati ili zakljuèati operativnu SIM-bravu, Nokia prvo 
upuæuje Kupca na otkljuèavanje ili zakljuèavanje operativne SIM-brave prije 
nego ¹to se Proizvod popravi ili zamijeni.

6. Ova ogranièena garancija ne obuhvaæa gubitak kvalitete uslijed uobièajenog 
tro¹enja i habanja Proizvoda. Ova se ogranièena garancija takoðer ne primjenjuje 
ukoliko:

i je do kvara do¹lo iz razloga jer je Proizvod bio kori¹ten suprotno uputama o 
kori¹tenju, grubo rukovan, izlo¾en vlazi, pari ili ekstremnim toplinskim ili 
vremenskim uvjetima ili naglim promjenama takvih uvjeta, koroziji, oksidaciji, 
neovla¹tenim modifikacijama ili vezama, neovla¹tenom otvaranju ili 
popravcima, kori¹tenju neovla¹tenih rezervnih dijelova prilikom popravaka, 
pogre¹noj upotrebi, nepravilnoj instalaciji, nezgodi, prirodnim silama, 
prolijevanju hrane ili tekuæine, utjecaju kemijskih proizvoda ili drugim 

postupcima izvan kontrole Nokie (ukljuèujuæi, ali ne ogranièavajuæi se na 
nedostatke potro¹nih dijelova, kao ¹to su baterije, koje po svojoj prirodi imaju 
ogranièeni vijek trajanja, na lom ili o¹teæenja antena), osim ako kvar nije direktno 
uzrokovan nedostacima u materijalu, dizajnu ili izradi;

ii Nokia ili ovla¹teni servis nisu obavije¹teni od strane Kupca o nedostatku u roku 
od trideset (30) dana od pojave nedostatka unutar garantnog roka;

iii Proizvod nije vraæen Nokii ili ovla¹tenom servisu u roku od trideset (30) dana od 
pojave nedostatka unutar garantnog roka;

iv serijski broj Proizvoda, pomoæni datumski kod ili IMEI broj na Proizvodu je 
uklonjen, izbrisan, izmijenjen ili neèitak;

v kvar je uzrokovan nepravilnim funkcioniranjem celularne mre¾e;
vi kvar je uzrokovan èinjenicom da je Proizvod bio kori¹ten ili povezan s priborom 

koji nije bio proizveden ili nabavljen od Nokie ili je kori¹ten u svrhe za koje nije 
bio namijenjen;

vii kvar je uzrokovan kratkim spojem baterije ili lomom pokrova na èahuri baterije 
ili æelija ili postoje znakovi neovla¹tenog rukovanja ili je baterija bila kori¹tena u 
drugoj opremi; ili

viii software Proizvoda mora se promijeniti zbog promjena u parametrima celularne 
mre¾e.

7. Kako bi postavio zahtjev temeljem ove ogranièene garancije Kupac treba 
predoèiti ili i) èitljivu i neizmijenjenu originalnu garancijsku karticu u kojoj su 
jasno naznaèeni ime i adresa prodavatelja, datum i mjesto kupnje, tip proizvoda 
i IMEI ili drugi serijski broj ili alternativno ii) èitljiv i neizmijenjen originalni raèun 
u kojem su naznaèeni isti podaci, ako je taj kupoprodajni raèun predoèen 
prodavatelju/distributeru Proizvoda.

8. Ova ogranièena garancija je Kupèevo jedino i iskljuèivo sredstvo naspram Nokie 
i predstavlja Nokiinu jedinu i iskljuèivu odgovornost naspram Kupca za 
nedostatke i kvarove na Proizvodu. Ova ogranièena garancija zamjenjuje sva 
ostala jamstva i odgovornosti, bilo usmena, pismena, (ne-mandatorne) zakonska, 
ugovorna, prekr¹ajna ili neka druga. Nokia ni u kojem sluèaju nije odgovorna za 
neku sluèajnu, posljediènu ili indirektnu ¹tetu, tro¹kove ili izdatke. Nokia takoðer 
nije ni u kojem sluèaju odgovorna za direktnu ¹tetu, tro¹kove ili izdatke, ako je 
Kupac pravna osoba.

9. Za svaku promjenu ili izmjenu ove ogranièene garancije potrebna je prethodna 
pisana suglasnost Nokie.
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GARANCIJSKA KARTICA

ISPUNITI VELIKIM ©TAMPANIM SLOVIMA

Ime Kupca:

_____________________________________
_____________

Adresa:

_____________________________________
_____________

_____________________________________
_____________

Zemlja:

_____________________________________
_____________

Telefon:

_____________________________________
_____________

Datum kupnje (dan/mjesec/godina):

|__|__| /|__|__| /|__|__|

Tip proizvoda (na telefonu etiketa ispod 
baterije):

|__|__|__| − |__|__|__|

Model proizvoda (na telefonu etiketa ispod 
baterije):

|__|__|__|__|

Serijski broj telefona (na telefonu etiketa ispod 
baterije):

|__|__|__|__|__|__|/|__|__| /|__|__|__|__|__|__|/
|__|

Mjesto kupnje:

_____________________________________
_____________

Ime trgovine:

_____________________________________
_____________

Adresa trgovine:

_____________________________________
_____________

Peèat


